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/helpconsole2010/nceesfaqs/docs/20121116TeacherUpdate.pdfWelcome to the North Carolina
Educator Evaluation System FAQs

 
If you have questions about the North Carolina Educator Evaluation System, there’s a good chance you’ll find the answer here.
If you don’t, feel free to ask a question of your own by contacting the McREL Customer Care Team at: customercare@mcrel.org
We'll answer your question as quickly as possible. The questions and answers are organized into categories which are listed at
the left side of the screen.  

Technical How-to FAQs involve issues related to the nuts and bolts of the system. These types of questions will answer such
things as "how to get connected" or "what type of browser can I use".

Teacher and Principal Process FAQs will answer questions about the processes of using the NCEES to complete the evaluation process.

District Coordinator FAQs are answers to questions that the district coordinator will have about supporting the North Carolina Educator Evaluation System.

Here is a link to a PDF document with all the frequently asked questions that can be saved to your computer or printed.

FAQ PDF Manual

Regards,

McREL Customer Care Team
customercare@mcrel.org

Welcome . 1

 

nceesfaqs

http://customercare.mcrel.org/helpconsole2010/nceesfaqs/docs/20121116TeacherUpdate.pdf
https://mxweb3.media-x.com/home/ncval/
https://mxweb3.media-x.com/home/ncval/
mailto:%20customercare@mcrel.org
http://customercare.mcrel.org/helpconsole2010/nceesfaqs/docs/manual.pdf%20
http://customercare.mcrel.org/helpconsole2010/nceesfaqs/docs/manual.pdf%20
mailto:customercare@mcrel.org


Expand All

 

Home > Technical How-to FAQs

Technical How-to FAQs   

Support FAQs

Who should I contact if I have questions?

1.  Contact your LEA District Coordinator for

Password resets & to request your User ID.

Changes that need to be made on your NCEES Profile (e.g.; email change, last name change, title or status change, etc).

Any questions that start with "How do I...?"

2.  Send an email to customercare@mcrel.org for

Technical problems (e.g.; technical malfunction, software bug, etc).

New NCEES feature requests.

Navigation of the NCEES System.

What information is helpful to provide when reporting an issue with NCEES?

1.  Who is affected? Include all individuals if it is more than one person by name, school name and UID.

2.  If possible include screen captures of what you’re using and seeing as it relates to the problem.

3.  Please include a full written description of the issue. Please resist using acronyms that may not be common to all, i.e. BT for Beginning
Teachers, etc. It is best to spell out acronyms to avoid confusion. 

4.  Basically; always include the Who, What, When & Where details as it relates to the problem.

If we can avoid replying back to ask for additional information it will help to expedite our ability to define a resolution and rectify
any problems. The more information we have the better we can work to help you.

Username & Password FAQs

How do I get help if I forgot my password?

1.  Temporarily disable any browser pop-up blockers.
2.  Locate the Lost Password? button on the NCEES login page:

3.  A separate small window will open as follows:

4.  Enter your User ID (UID) which is the full numeric ID provided by your District Coordinator.  If you are unsure of your username, you
may enter your email address instead. Then click on the Next button.

5.  After clicking the Next button the following window will appear:
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6.  Open your email inbox. You should have received an email with the subject “MxWeb password reset request” (see example below).

Follow the directions in the email and click on the link to reset your password.

7.  The resulting window will show your newly reset password (case sensitive):

9.  Write your new password down.  Click on the Go to login button and enter your username (UID) and the new password.

10.  Once you have logged in successfully, you can follow the direction in this FAQ on changing your password if you choose (see How do
I change my password?). 

Note: After logging in with the reset password, the link provided in the email (above) cannot be accessed again. You will get the
following error message:

                            

Can I change my password?

To help assure the security of the system, all users should reset their passwords from the default "123456".  We advise people to change
their passwords the first time they login to the system.  By doing so, they create a 2-step security check as both their unique ID numbers
and their passwords must be correct before confidential information can be accessed.

How do I change my password?

1.  To change a password after logged into the system, look in the upper left corner of the screen.  There you will find the System
Functions area.  In this area you will see an icon titled Profile.

2.  Click on the light green Profile button seen in the image above.

3.  From the resulting web page click on the Change Password button in the upper left corner.
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4.  A small window titled Change password will open (see image below):

5.  The old password will be the password that works now. The New password and Confirm password fields are where you will put the
new password you intend to have. Then select Save. You will not be prompted or advised that it was changed.

The Lost Password feature failed to reset my password. Can I still get my password reset through other means?

Please send an e-mail to your District Coordinator and type in “Password Reset” in the subject line. Please include your school’s
name. The District Coordinator will notify McREL by sending an email to customercare@mcrel.org. 

I never received the email with my reset code after following the "Lost Password" directions?

Here are steps to take and if you did not receive an email from the system with your reset code described in the "Lost Password"
directions:

1.  The e-mail from the system may be blocked by your server or may be going to spam. In the case of spam check your spam folder or
your district's IT department.

2.  Make a request for a password reset through your District Coordinator or by sending an email to customercare@mcrel.org.

3.  Once you are able to successfully login to your account check your email address in your profile. If it does not match the email you are
actively using, contact your District Coordinator to request it be changed.

Are passwords case sensitive?

Yes, passwords are case sensitive.  Also, be sure to double check that your "Caps Lock" key is not activated when entering your
password.
 

May I use a temporary ID until the UID is issued?

No, you cannot use temporary ID numbers. The demo site can be used to become familiar with NCEES until your User ID (UID) is issued.

Is it possible to lock my account?

No, it is not possible to lock your account.

Can I change my username?

No, your username (UID number) is unique to you and enables the system to keep track of the information that is pertinent to your
account.

Website FAQs

What is the website address (URL) and how do I login?

The website address for the NC Educator Evaluation System is https://mxweb3.media-x.com/home/ncval/ 

Login Instructions:

1.  Choose your specific district from the drop down menu. If you are at a Charter School, choose Charter Schools (at the very top).

2.  Type in your assigned username (UID number).
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What is the domain name that notification emails are sent from in the online evaluation tool?

This is an important question.  This information is critical to assuring that email messages are successfully received, such as password
reset emails.  At times email may be blocked or a Websense firewall or a SPAM fileter may prevent delivery of certain content. These
FQDN’s (Fully Qualified Domain Names) should be allowed to process in and out of your district’s domain and should be trusted in your
browsers to ensure the content passes unimpeded:

Media-x.com
Mail.media-x.com
www.media-x.com

3.  Type in your password. Remember your password is case sensitive.  If you do not know your password please click the Lost
Password? button, or contact your District Coordinator.

FAQ My screen is “smashed” together, meaning that I cannot see all of the observations that I completed on a teacher. How can I view
the entire screen?

1.  Confirm your screen resolution is set to “recommended” or 1280x800 or higher.

 

2.  To relieve or reduce the compression of the frames & tables that constitutes NCEES Click F11 on your keyboard. This will allow you to
see the browser Full Screen. You must click F11 again to view the normal screen.

How do I change my icon sizes or correct Spell Check language conventions?

Open a new browser and enter the following URL: https://mxweb3.media-x.com/Profile/Profile_Settings.php. Follow directions to
change Interface Settings (spell check language settings) and/or change icon sizing.

Printing FAQs

Why are the check boxes not showing when I print my self assessment?

In order for the check boxes to print you must enable Background Printing . See directions below on how to turn your background
printing on or contact your IT department. It is possible that your IT department has removed privileges that allow you to choose
background printing. If you are using Windows 7 you must implement BOTH a and b in option 2:

1.  Internet Explorer (IE) 7 on any version of Windows: 

Go to Tools>Internet Options>Advanced tab>scroll to Printing>check the box next to Print background colors and images>click
Apply>click Ok

2.  Internet Explorer (IE) 8 on any version of Windows (both a & b):

a) Go to Tools>Internet Options>Advanced tab>scroll to Printing>check the box next to Print background colors and
images>click Apply>click Ok

b) Go to Tools>File>Page Setup…>check the box next to Print background colors and images>click Apply>click Ok

3.  Internet Explorer (IE) 9 on any version of Windows:

Go to File>Page Setup...>check the box next to Print background colors and images>click Ok

4.  Firefox: 

On the File menu, click Page Setup. On the Format & Options tab>Options>select Print background (colors & images)>click Ok

5.  Safari: On the File menu, click Print. On the Copies & Pages pop-up menu, click Safari. Select Print Backgrounds. Click Ok
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[If you do not see the menu options in IE as defined above try right clicking on the header bar just above a tab in IE. You will see check
marks next to active and visible features in IE. Select Menu Bar] Here are some resources to show you how to display the menu bar in IE.

My LEA or school district has disabled Background Printing for all computer users throughout the entire district. How can I still get a printed
copy of NCEES forms since I cannot enable Background Printing??

A PDF print option to bypass background printing functions:

1.  Open the form just as you would any other time.

2.  Select the Print button in the upper left side:

3. The printable version will open in a new browser window. Look for the following buttons at the top of the printable rubric:

4.  Select Print as PDF.

5.  You will be prompted by the browser's security notification feature asking you to accept the download. Select the security notification
and choose Download File as shown in the image below.

Note: There is a chance where if too much time passes prior to selecting Download File you will need to select Print as
PDF again.

6.  After you select the Download File from the security notification, the following prompt will be displayed:

7.  Save the PDF file to a desired location on your computer where you can find it.  After the download completes navigate to the file. 

Forms FAQs

What types of files can I attach to the form?

You can attach the following types of documents to your forms where allowed:

PDF

Microsoft Word
.doc

.docx

Microsoft PowerPoint
.ppt

.pptx

Microsoft Excel
.xls

.xlsx

What is the maximum file size limit for attachments?

The maximum size that will be allowed for uploading an attachment to a form is 2 megabytes (MB).  You can check the size of a file by
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right-clicking the file and selecting properties in Windows Operating systems.  If you are using a Macintosh operating system then right-
click the file and select Get Info to find the size of the file you wish to upload.

How many artifacts can I attach to a self assessment and/or observation?

Users are allowed to attach three artifacts per standard, for a total of 5 files (5 standards) per self assessment and / or observation. We
also offer a digital Link for linking additional references teacher or principal might have online.

The Start Time and End Time I’ve set in observations are not saving. What can I do to correct this?

In order for the times in observations to be saved the Date (to the left of the time) must be set first. That Date is the day you actually
perform the observation. Set it first and then set the time and save the observation.

Hardware/Computer FAQs

What are the computer or system requirements to use NCEES on a laptop or desktop?

1.  Any computer capable of handling Internet Explorer (IE) 7 or higher, Safari 4.0.4 or higher or the latest version of Firefox.

AND

2.  A screen resolution set to “recommended” OR is at least 1280x800 or higher.

McREL does not support NCEES using hand-held devices. While NCEES will work with iPads and other hand-held devices, McREL cannot
provide any support and/or guidance. The only exception is scrolling with the iPad (see below).

I am using an iPad and I can’t scroll down. How do I scroll so that I can continue with the observation?

In order to scroll down on the iPad, you must use two fingers on the screen where you want to scroll. One finger alone will not scroll.

Technical How-to FAQs . 7

 

nceesfaqs



Expand All

 

Home > Teacher & Principal Process FAQs

Teacher & Principal Process FAQs 

Common Process FAQs

What am I required to do?

To get the answer to this question, it is important that you contact your Principal or Human Resources office for answers on what your
responsibilities are for using the NCEES system. Process manuals for the Teacher and Principal are available on the NC DPI Wiki Site.

How can I get additional training?

Training of individuals on the use of the NCEES system is handled by your District Coordinator. Please contact that person to find out
what options are available to you for training.

Where can I find information about the evaluation process?

Information about the evaluation process can be found on the landing page of the NCEES system under the Resource Documents
section. There you will find the NC DPI Wiki link, FAQ link, Teacher and Principal Evaluation Process links available.

There are also step-by-step Online Tool Direction guides for teachers, principals, and superintendents.

How are the Electronic Signatures completed?

The signature process is designed, in most cases for the evaluator to sign first. However, when the evaluator signs, the form is locked
from making any changes. It is important that no signatures are added until the form is reviewed for accuracy. Comments above the
signature area (as seen on the PDP) must be entered prior to the principal's signature. Comments beneath the signature area cannot be
added until signatures are in place. Therefore, please use caution before signing by to ensure the document is complete. Forms cannot be
'unsigned'. Please follow the steps described below.

 

1.  Principal:

Create new observation, fill it out completely. At the bottom, click the check box to sign. Important: Once this is signed, the principal
cannot go back to make any changes/edits, including the date or time.
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Once you have clicked the check box to sign, you will receive confirmation (see image below) asking if you are sure that you want to sign
the form.  If you are sure you want to sign click OK.

After clicking OK a new window will display.  This window asks for your NCEES password.  Your password will authenticate the electronic
signature verifying your identity.

Once authenticated, the screen refreshes.  You will now see that because the form is signed all fields are grayed out indicating that no
more edits can be made to the form. 

Note: Comments made to an Observation or the Summary Evaluation Rating Form by the evaluee cannot be added until the form is signed
by all parties.

Next, click the Done button in the upper left corner of the screen (see image below).
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2.  Teacher:

Ask the teacher to view their observation. Notice, both the principal and teacher status are in IN PROGRESS mode. Click rubric to view.

 

Notice, the principal signature is grayed out. No changes can be made. Teacher views and signs (merely an indication the teacher has
viewed).  Check the teacher signature box (far left)

 

The teacher will also be required to enter his/her password and click Authenticate.
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On the Observation form you will notice that both the teacher and principal signatures are grayed out indicating the form has been signed
by both.

The status now shows COMPLETED.  Comments may be added only after both signatures have been applied.

3.  Principal:

The principal will log into their account to view the teacher observation.

 

Click in to the rubric to view. Scroll to bottom and notice the teacher signed; and now the COMMENTS area is now live. The comments box
is provided to allow the teacher to add comments. While only a small line appears to be available, comments added will wrap and the area
will expand as appropriate. After entering comments be sure to check the COMMENTS ATTACHED box. Comments will be emailed to the
evaluator. Upon receipt of those comments, the evaluator will check the box that comments were added and then check the box to sign. 

Note: The evaluator cannot respond to the teacher's comments. Please check with your Human Resources department for direction on
how to document comments as a correction/clarification/rebuttal to the teacher's comments. The system is not designed to provide this
type of documentation. 
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I am assigned to more than one school, but I can only see information from one of the schools. What do I need to do so I can see the
other school?

If you function at more than one school you will need to be able to know how to switch between those two schools from within your
NCEES profile (found on the landing page of the system). Observations or self assessments from the other school(s) will be identified as
Offsite. You may view the document at the other location, but are not allowed to change that form. To make a change to the
Offsite form, you should also be aware that if you start a self-assessment for a certain school you will want your profile to be set for that
school or the will need to change your school on your profile. 

1. Log into your account and then click on Profile (prior to clicking on the NC Educator Evaluation System icon)

2. You will see that under your Current Role, your schools are listed. You must click on the school where you want to see the
information.

3. Click on the NC Educator Evaluation System icon and now you will see the information for the school you chose.

 

Note: In order to make changes to an Offsite document, you will have to go back into your profile and choose the school of choice. You
can only manage information at one school at a time.

What is the difference between a mentor and a peer?

Mentor observers will be tasked to handle specific PDP’s for specific teachers. Peer observers will handle Observations done on specific
teachers. Your District Coordinator or DPI can provide a full break down on the differences between a Mentor and Peer and can define
what their responsibilities are. 

How do we assign “peer” teachers to do observations through the online system?

You do not need to assign peer teachers within the system. When a teacher logs in they have the option to choose More… and
then Rubric for Evaluating Teachers. The teacher will be provided with a list of teachers from the school and they should choose the
peer teacher who was assigned to them. Teachers cannot view other teachers’ peer evaluations.

Can I recover an accidentally deleted Observation, Assessment or other item in NCEES?

No. Be sure to heed the alert prompts that come up when deleting an assessment or observation. It is not recoverable following the
delete. 

When the teacher views the observation rubric, can they make any changes or add comments, files to that document?

The teacher may not make changes to the Observation Rubric itself but they can add comments to their observations only after it has
been signed by both the evaluator and the evaluee. The resulting comment will automatically be emailed to the principal.

In order to add comments the principal and the teacher must first sign. 

Open the Rubric and scroll to the bottom. The Add Comments button is now be available:
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There is a small white line, just under the grayed out area where comments may be added. While this appears to be a single line only,
text entered here will wrap. When finished, be sure to click the Add Comments button. You will receive a warning asking Are you sure
you want to add this comment? 

Note: Comments cannot removed after added. Click OK or Cancel. 

By clicking OK, an email will be sent to the evaluator. You must acknowledge this statement: The email has been sent. Your comments and
the date they were added will flow to the grayed out area:

Again, the comments will flow, along with a date stamp to the grayed out area. An email with the comments entered will be sent to the
evaluator automatically. The principal will acknowledge the comments, click  the box Comments Attached and sign. The evaluator
cannot respond to the teacher's comments via the NCEES system. Please check with your Human Resources department for guidance if
needed.

The number of self-assessments reported as complete does not match what the Rubrics Report is stating. How can I correct this?

The Rubrics Report which provides data on completed Evaluations / Observations and Self-Assessments will need to have the date set by
the teacher in their self-assessments. That date is the trigger that tells the reporting mechanisms the self-assessment is indeed complete.

Principal Process FAQs

As an administrator or principal, I cannot see the principals’ or assistant principals’ names in order to complete an observation. How do I
see them?

You must Create a group using a process that is different than managing groups for teachers:

1.  Log into your account and then click on Group Manager under the Admin Functions (prior to clicking on the NC Educator
Evaluation System icon).

2.  In the Group List column, click Create member group.

3.  In the Site List column, click on the school in which you want to create a group. The school name and Administrator, Principal, and
Teacher will pop up below. Click on the plus sign next to Administrator and/or Principal.
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4.  Click on the person’s name and they will move to the Group Editor column.

5.  Rename your group in the Group name box. (You may set up as many groups as you need.)

6. If you need to share your group with other district administrators you may do so. Please note: It is recommended to only share groups with
another district administrator(s).  Principals should be encouraged to create their own groups as necessary.  To share, click on the SHARE GROUP
icon. If you share, remember those who have access  may view observations for all. You may share with: a USER, a MEMBER GROUP, or a
SITE. McREL recommends always selecting the USER. Enter the username* of the person who will share the group in the area provided. Click
ADD. Next you will provide this person the access necessary:

R=Read, W=Write, D=Delete, S=Share

Generally, you will not use the “X” as this blocks access. Toggle on and off of each to provide permissions or restrict
permissions. Click the RED X in the upper right-hand corner to close out of the share group screen. 

 
*Username is how the user logs into the system.  Do not enter the person’s name in this area.

7.  To save the group, simply use the breadcrumb trail (navigation in the green bar) and click on mxWeb

8.  Click on the NC Educator Evaluation System icon

9.  Choose Observe/Report>Principal/Assistant Principal Performance Evaluations

10.  Use the drop down menu in the Select Group area to choose the group that you created and you will see the people listed below.
Click on a person’s name and then click New Evaluation.

Note: The Set Permission Default in Group Manager does not apply to the NCEES system. Unfortunately, it is not possible to
disable the icons, so please be aware is it not necessary for use when "sharing" settings.

How do principals setup mentors in NCEES to handle teacher PDPs?

Mentors may only be assigned to a Professional Development Plan. Here is the process for setting up a Mentor in NCEES:

1.  Open the Professional or Preliminary Development Plan (PDP).
2. From the Select Mentor Site choose the school site where your Mentor is seated.

3.  Further to the right of this drop menu the Select Mentor Name drop menu will show an available list of individuals at this site.

4.  Select your Mentor from the list.
5.  Click Save in the upper left corner.
6.  The Mentor will login and navigate to More which is just underneath Observe/Report and then Rubric for Evaluating Teachers:

7.  The Mentor will see their assignee's name on the lower section of the next screen. Mentor will click on the PLAN NAME to access the
form:

The mentor may only sign the beginning year tab. The mentor may add comments to the Mid-Year and End-of-Year tabs and sign.

While the mentor may sign at any time, it is recommended the mentor add comments first and sign prior to the principal. The
teacher may add comments, but sign after the principal.  As soon as the principal signs, no comments may be added to the PDP.
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How do I as a principal, see a teacher’s self assessment?

The teacher must give the school principal access to the self assessment.

1.  After a teacher has completed his/her self assessment, and if he/she chooses to give the principal access to it, then click in the box
next to I completed my self assessment and now the principal can view it.

2.  In your account, click on Observe/Report and then Observations. Click on the teacher’s name from the list available, and then
click on the Teacher Task tab. You will know that you are on the Teacher Task tab if it is a dark blue and the Observer Task tab will be a
light blue. You may then click on the teacher’s self assessment to view it. You cannot make any changes to it. 

As a principal where can I find the area to setup the forms?

This answer shows the principal how to setup, or create the Teacher Observation and the Teacher Summary Rating form. The
Record of Teacher Evaluation Activities form will automatically populate when the principal clicks on the specific teacher's name. The
Professional Development Plan and the Preliminary Development Plan are available on the Teacher Task tab; the teacher is responsible for
creating the Preliminary Development Plan if new to the school. 

1.  Log in as a principal

2.  Go to Observe/Report.

3.  Select Observations on the right.

4.  Select a teacher from the list of teachers.

5a.  Select New Observation or New Form (to create the Summary Rating) from the upper navigation bar:

-OR-

5b.  Click on the button labeled New to the left of the text Observation or Summary Rating Form
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OBSERVATION FORM View

 

SUMMARY RATING FORM View

6.  The following fields can be renamed:

            a.  "Observation Name” or "Form Name"
     b.  “Principal First Name”  
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     c.  "Principal Last Name"

At what point should an administrator lock the evaluation rubric? Do we lock it while we are working on it or when it is reviewed by teacher
or when the process is complete?

The evaluation will automatically be locked when the process is complete. When the evaluators save the summary rating sheet with ratings
completed, they should be prompted to sign off on the form. Once the evaluator signs off, the system will prompt the teacher to sign
electronically as well. When both signatures are in place, the evaluation is locked and cannot be unlocked by either the teacher or the
evaluator.

Note: When the Summary Rating is signed by the principal, a Professional Development Plan will be created. This PDP is intended for the next
school year and will appear on the Teacher Task tab for the following school year. If the principal and teacher want to identify goals to be worked
on for the next year, it is this PDP appearing under the Summary Rating Form that will be used:

 

On the New Preliminary Development Plan, I am unable to type in section A-Standard(s) to be addressed: and Element(s) to be
addressed:. Why can’t I type in these boxes?

This is by design. You are unable to type in these boxes because this is the first time you have used the system. Those fields will
automatically be filled in on the Professional Development Plan that is completed at the end of each year. Since this is your first use of the
system, your Preliminary Professional Development Plan will be based on your self assessment, and you will write this year’s goals based
on that and your conversation with your evaluator. All of your subsequent evaluations will use the Professional Development Plan that is
automatically generated following your end-of-year conversation with your evaluator.

 

When I am doing observations, can I pull up a previous observation to add to it or do I have to do a new observation rubric for each
observation?

You can pull up the previous observation and add to it. The key is to save it with a new name once the observation is complete. We
recommend something totally uncreative but very clear such as:

 

 

2010-11 Observation 1

…and then the next version would be …

2010-11 Observation 2

 

Using this method, you can then see what the teacher has done throughout the year when you get to the final observation.
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Support FAQ

Who can I contact if I have questions?

Please contact customercare@mcrel.org for the following types of issues:

a.  Spreadsheet “Working File” queries
b.  Technical Break-Fix requests
c.  Navigation of the system
d.  New NCEES feature queries

 

 

Please contact the NC Department of Public Instruction (DPI) for:

a.  Training resources
b.  Policy questions
c.  System enhancement requests

What information is helpful to provide when reporting an issue with NCEES?

1.  Who is affected? Include all individuals if it is more than one person by name, school name and UID please.

2.  Include screen captures of what you’re using and seeing as it relates to the problem.

3.  Please include a full written description of the issue. Please resist using acronyms that may not be common to all, i.e. BT for Beginning
Teachers, etc. It is best to spell out acronyms to avoid confusion. 

Note: If we can avoid replying back to ask for additional information it will help to expedite our ability to define a resolution and rectify any
problems. The more information we have the better we can work to help you.

Requirements and Training FAQ

What am I required to do?

To get the answer contact the Department of Public Instruction’s training team, or check the NCDPI Wiki Site for clarification. 

How do I get additional training?

To get the answer contact the Department of Public Instruction’s training team. Check the NCDPI Wiki Site for further direction. 

Back-Office FAQ

There are people listed in my spreadsheet who are no longer at my school. How should I remove them?

Simply delete the entire row for anyone who is no longer at your school from the spreadsheet.

Add new people are added to a new row on the spreadsheet with all of the appropriate information.

In the event that a person has moved to a different site within your LEA, simply change the Site ID number to the correct number.

Where do I get the UID numbers for new employees?

The UID numbers can be obtained from your payroll department.

Can I create a temporary ID until the UID is issued?

No, you cannot create temporary ID numbers. You should direct individuals waiting on their UID to use the demo site to become familiar
with the environment prior to being issued their own User ID (UID)

Do I have to get the UID number or can I make one up?

You must use the UID number assigned to you by the payroll system. 

Exception: If you have a user who will not ever receive a UID number, please contact NCDPI to obtain a special UID number.
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You will encounter situations where a new staff comes to the district without a UID and it takes a month for payroll to provide a UID. This
exception does not apply here. You must wait for the UID from payroll.

I have additional updates to make with new teachers. Can I make them on my own?

No, please always use the spreadsheet for updates. Send your updated spreadsheet to customercare@mcrel.org when appropriate. E-
mail the entire spreadsheet.

While district administrators may see the ability to Create member within the Site Manager screen, due to licensing agreement and
subscription licensing, adding personnel within the Create member option will not give full access to an employee. All personnel changes
must go through the spreadsheet process.

Should I include my counselors, media specialists, school psychologists, etc. in the spreadsheet?

No. The principal and teacher observation rubric does not apply to Central Office personnel. If in doubt, please check with NCDPI or refer
to the NCDPI Wiki Site for clarification.

I have a teacher who travels between two or more schools and has observations completed at all schools. A.) Can I list them at both
schools? B.) Can the principal see the observations at both schools?

A) Yes, it is necessary to list the teachers at each school they are assigned. 
B) No, principals at each site can only see the observations at their own school.

I moved a user from one site to another site. Will the password automatically changed back to 123456 (default password)?

No, the password will remain following any change on an existing account within an LEA.

A teacher moved to our district from a different district. Will their password stay the same?

No, the password will default to 123456 when they change districts.

Other FAQ

McREL Evaluation systems to determine, and/or continue from past practice?

During the Professional Development (PD) session you will spend some time discussing, what is referred to as, the P-Chart. This chart is a
series of discussion items that help districts think through exactly your questions.

Generally you will find that the districts don’t necessarily need to create anything new rather reconsider or reemphasize that the
evaluation process must be taken very seriously and is intended to solicit professional growth. 

While these are very basic concepts, we encourage districts to go more in depth with their internal discussion so as to bring clarity and
detail to the policies, procedures and practices. During the PD session we want to, at a minimum, surface these types of discussions and
encourage districts to periodically resurface the conversations just to keep the emphasis on professional development and growth.

Would a summative evaluation be occurring yearly?

The recommendation is yes. Much of the literature surrounding teacher and leader effectiveness is that, in some instance, individuals go
several years without any formal observation or feedback regarding their performance. This is a policy issue, however. McREL encourages
districts to re-examine such policies and align policies with practices and procedures in order to give the best chance for the evaluation to
do what is intended to do. Always check with a NCDPI member with questions or issues requiring clarification. 

Is it ok to focus on a portion of the rubric each year (like over 3 years) and then cycle through portions of it again, or would we focus on
the whole rubric each year?

Focus on the whole rubric (all standards) each year, However, based on an individual’s experience (Career Status Teacher only) you may
opt to select the Abbreviated Version (Standards 1, and 4 only). If using the Full Version (Full Version is required for all Probationary
Status Teachers), the evaluator may mark the not looked for button within the Not Demonstrated category. For example; a
beginning or probationary teacher may not be required to focus intently on some elements contained with the rubrics. Therefore, clicking
the box labeled Not looked for within the particular standard/element would not be reflected against the evaluee in their
evaluation. Another alternative is to continue to develop an evaluation over the course of the year. Meaning that the evaluator will focus
on certain standards of certain times throughout the course of the school year. Thereby allowing the evaluation to unfold over the course
of a year. These are discussions that should occur during training; or defer to NCDPI members for discussion and/or clarification. 

Would individuals still determine their goals or would the software suggest one or more based upon evaluation results?

The software will indicate which Standards and Elements that have been determined to be Not demonstrated or Developing and
reflect those on the Professional Development Plan for teachers or the Goal Setting Form for principals. This can and should provide the
foundation for the evaluator and evaluate to determine goals for the upcoming school year. In the case where an evaluate does not
have any standards marked as Not demonstrated or Developing, then the evaluator and evaluate would collaborate on the goals
that are most meaningful to the individual.

Should folks quit making goals such as “Student achievement in math concepts will increase by _ as measured on the _ assessment
by_(date).

For year one, do the goals have to focus on the McREL rubric, or do we pick a weak area from whatever evaluation paperwork was done
before?

If the goals or weak areas of performance align with the new set of rubrics and evaluation system then you can certainly set performance
goals around those areas. Another option for the first year would be to set goals based on the evaluee’s SelfAssessment and the
evaluator’s estimation of the evaluee’s performance using the standards for performance.
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What if someone meets their PD goals mid-year?

That would, of course, be optimal then during the mid-year evaluation conference goals could be adjusted to continue professional
growth. Here is a very simple example: A goal for a teacher might be designed and worded to improve their classroom structure to
maximize time on task. One piece of maximizing time on task is finding alternative ways to take roll that does not consume a Lot time. The
goal setting process should require a time to which the evaluator would expect performance to improve. In this case it might be by the
end of September. So the teacher has done some work to be more efficient at taking roll within the time frame. Now, look and assist the
teacher with other strategies to maximize time on task. e.g. Transitions between activities…etc. In that case we can see the
improvements and there is consistency and quality within those improvements, at mid-year we can re-adjust goals or expand goals to
elicit more improvement in the same or other areas that are reflected in the rubrics.

How are multiple observations recorded?

Each time an observation is conducted the evaluator can use a “New” set of rubrics for the observation or they can copy a previous set
of observation rubrics and then add or delete from the previous set. In both cases the evaluator would have two distinct sets of rubrics
that reflects two separate observation

If an evaluator is generating a New observation, let’s say observation # 4 then the New Observation screen allows the evaluator to
select a new observation or build on the whole evaluation using a copy of a previous observation. In either case the evaluator would be
generating an additional observation. In this example it would be Observation # 4.

Does the software just record what’s been entered into the system or does it generate some info and/or suggestions on its own?

Currently, the software only transfers the final ratings from the Summary Evaluation Rating Form to the Professional Development Plan
for teachers and the Goal Setting Form for principals.

Define a Probationary (Beginning) Teacher and a Career Status Teacher

Probationary Teachers: Teachers who are in the first three years of teaching and who hold a Standard Professional 1 License. Probationary
Teachers must be rated as “Proficient” on all five Professional Teaching Standards in order to be eligible for the Standard Professional 2
License.

Career Status Teachers: Career Status Teachers are teachers who have been granted Career Status in their current North Carolina school
district. 

(Information provided in the Teacher Evaluation Process PDF manual, written and approved by NCDPI: P18)

Who can delete a form?

Generally, the author of a form may delete that form as long as it is not signed. A form where the bright red X is displayed (to the left of a
form name) signifies the ability to delete a form. 

Extreme caution must be used before considering deletion as deleted forms cannot be recovered. Before deleting, it is recommended the
user make a print of the form. 

If a form is signed, only the person with District Administrator privileges may delete the document. The red X will be grayed out for
teachers and principal roles.

Note: There are two forms which cannot be deleted: Professional Development Plan, appearing on the Teacher Task tab and the Record
of Teacher Evaluation Activities Form, appearing on the Observer Task tab. District Administrators may unsign a specific tab of the
Professional Development Plan and "refresh" the Record of Teacher Evaluation Activities form; but neither of these forms may be deleted.

How do I get records for teacher who has left the district?

When personnel leave the district, removing them from the spreadsheet will deactivate that employee. Observations and any other forms
created for that employee are no longer viewable. There are times when that deactivated employee's records may need to be reviewed.
In order to view or print copies of forms, the employee will need to be reactivated.

On the landing page, click on the Site Manager icon:
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Click the box to expand the school district to display school names:

Highlight school of interest:

Click the Member button. Click the role of interest (i.e., Administrator, Principal or Teacher). Click View inactive members:

Click the green arrow to re-activate the employee and their forms. After re-activating employee, click on the link View active members to
ensure the person of interest has successfully been restored. Once the employee is active, all forms created become active. You may log
into the school location to view and/or print this person's records. Be certain to deactivate the employee after the necessary records have
been secure.

To deactivate the employee again, follow the steps above; clicking on the red arrow to deactivate. To ensure employee has successfully
been deactivated, click on View inactive members.
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